
 

 

 

TM 

P
ag

e1
 

Creating a myBrainshark Presentation 

Creating great content in myBrainshark easy! Apply the best practices we suggest here, and you’ll be well on your 
way to creating a message that engages your audience and gets the results you are looking for. This document will 
help you take your ideas and mold them into great content, then help you get that content into myBrainshark. 

 

Analyze Your Audience 

Audience analysis is a critical step in the presentation development process and needs to happen before you begin 
creating any content. You need to know who your audience is and what THEY want to see and hear, so you can 
deliver a message that they will watch and will drive them toward your objective. 
 
Think about the audience as a whole to determine what information you need to uncover to effectively analyze 
them.  

 What is the age range of the group? Are there any cultural issues you should be concerned with?  

 Will the audience be receptive to your message? What makes them happy or gets them excited about a 
product or service? 

 What kind of information do they want? How do they want to receive the information? 
 
Then consider any concerns your audience might have. Understanding audience concerns puts you ahead because 
you can address them before they have a chance to stick in the minds of the viewer. 

 How about previous experience with your product or message? Have they received any previous data from 
myBrainshark or similar type of media? What was the reaction? 

 Is your product or service cost very high? Be sure your message addresses why that is and why the benefit 
justifies the cost.  

 Are you looking for buy-in for something? Do you want your viewers to take action or react to your 
message? What will it take to get the viewer to do what you want him/her to do?  

 What barriers exist? What preconceptions, perceptions, or misconceptions exist?  
 
Finding this information out may be easy, or it may be challenging. Depending on who your audience is, you may be 
able to get information from: 

 Previous clients 

 Members of a focus group 

 Other colleagues or individuals in your industry 

 A survey conducted of your audience members 

 Information already available on the internet 
 
For each anticipated audience concern, you need to formulate a response; then use this to build the outline for your 
presentation. As you build your outline, keep all of the information you have discovered about your audience top of 
your mind so you are sure that the overall presentation, colors, and format will be appealing to the viewer.  
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Depending on how the audience wants to receive the information, maybe it isn’t PowerPoint you need to use to 
build your myBrainshark presentation. You can tailor your myBrainshark communication to meet their wants and 
needs so you ensure you get the most people to watch and act on your message! 

 

Pinpoint Your Objective 

Determine the objective for your presentation by looking at your ultimate goal. Is your goal to sell a product? 
Increase the amount of new customers you have? Reduce the amount of toxins in the environment? After you have 
set your objective, go back to the audience analysis work you already completed.  

And ask yourself: 

 Does this objective fit in with the needs of the audience?  

 Does this objective align with the objectives of the company or organization?  

 Does my communication hit the mark?  

 

Craft Your Presentation Outline 

Creating a presentation outline helps you stay focused and on target with your presentation. Since you have already 
formulated an objective and analyzed the audience you are going to deliver to, you will use that information to 
write an agenda of what you want to cover in your communication. These are the basics of any agenda which you 
can tailor to meet your own objective, from sales to training to communication. 

Introduction and attention grabber 

You need to get the attention of the viewer and make that person want to take the time to view your 
communication. 

Summary of what you are going to cover in the presentation 

Tell the viewer what they are going to be watching in this communication. 

1-4 topics related to your objective 

Including too much information and too many topics will result in overload for the viewer, so keep it to no 
more than 4 main points. For example, if you were selling a product, give the basics of your product or 
service but reserve the specifics for when you make direct contact with your prospect.  

Case Studies to support your topics 

To make the point about your product, service, or communication, incorporate case studies when you can 
to help your audience identify with the points you are making. When they can “see” themselves using your 
product or service, or in the situation you are describing, they are emotionally connected to your 
communication. Use your audience analysis work to be sure the case studies are relevant to that audience. 
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Overview of pricing or package options (optional, sales communications) 

If your objective is to sell your product or service, you may wonder whether to include pricing information. 
There are two schools of thought on this. On one side, you could be up front about your prices and put all 
the information on the table. This is good for a company providing a set product or service where there is no 
room for customization. On the other side, if you provide your pricing information up front, you won’t be 
able to assess each customer situation exactly, and may not be seen as a trusted advisor. This is for you to 
decide. Perhaps you take the middle position and offer some pricing information but not give it all away, in 
hopes that you will get more customer contact.  

Overview of competitors and why your product or service is the best (optional, sales communications) 

If your prospects don’t know why you are the best, then cost becomes the driving factor in purchase 
decisions. You can take it a step further and contrast your prospect’s world without your solution and your 
prospect’s world with your solution. But whatever you do, make sure you show why the difference is 
relevant to the prospect.  

Summary and wrap up of what you covered in your communication 

You’ve just presented the viewer with a bunch of information, now you need to summarize it and tie it all 
together. If you used a case study, make sure you pepper your summary with references to the story so that 
the viewer keeps that information top of mind. 

Call to action for viewer including how to get in touch with you for more information 

No matter what your communication is, you want your viewers to take some sort of action. Don’t leave it up 
to them to figure out: tell them what you want them to do. Also, depending on your objective you may want 
your viewers to be able to contact you for more information, so include your contact information if that is 
the case.  

 

Write a Compelling Script 

Now that you have written the outline of your presentation and know the direction you want to go, it’s time to take 
those ideas and write a detailed script of what you want to say. You might be thinking: I have a slide deck I can use, 
can’t I just wing it when I record audio? Your script is the meat of your presentation. It ensures that your audio will 
deliver a consistent message. Also, you will rely on the script to build your visuals, not the other way around. Skip 
scripting and dive straight into audio and you’ll find yourself tinkering with what you want to say and likely missing 
the mark. 

If you are using PowerPoint, copy the sections of your outline into the slide notes area for each slide. This process 
reduces the amount of time you spend swapping back and forth between your outline and your script. Make sure 
that each main point covers at least 1 slide, and be aware that you may need to break key points into multiple 
slides.  

Expand on the outline you copied into the slide notes and create a detailed script for each slide. Use terminology 
and phraseology that fits with the industry and culture, as well as with your audience’s knowledge. Be 
conversational and don’t leave out words since this will be a stumbling block during the audio recording process. 
Ensure you have proper transitional phrases at the end of each slide so your audience is led into the next slide. 
Then, compare it all back to your objective for consistency in your message. 
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When you are finished scripting, go back and review your objective again as you are reading the script.  

 Why are you communicating this information? What is the ultimate goal?  

 Does the script fit with the goal? If not, you need to go back and rework your script.  

 Did you include a call to action for your viewer?  

 
 
Create a Winning Slide Deck 

If you are using PowerPoint as the base of your communication, adding visuals that reinforce your message 
increases the retention of information from 20% to 65%. So creating a compelling visual for your presentation is 
critical to ensure the effective delivery of your message.  

There are three things to consider as you pull all of the important points from your script:  

 Slide design 

 Text and images 

 Animation 

Slide Design 

If your slide design or template is visually unappealing, your audience might not stick around to see and hear your 
message. Setting an overall look for your presentation that is professional, appropriate, and appealing is the first 
step in engaging your audience. 

You may already have a slide template to use, which is great. If you don’t, you need to consider your business’ or 
organization’s color scheme or logo colors, images you might add, and the tone of the presentation so your slide 
design is consistent with your message. Additionally, consider how the colors, text, and images will look on a mobile 
device if you intend to enable mobile sharing.  

Text and Images 

Put your script in the slide notes in PowerPoint, so it will be easy to view what you are intending to say on each 
slide. Once you have reviewed your script for a slide and determined the important points, your first thought may 
be to create bullets. But, remember the old adage of “a picture is worth a thousand words”. Most people prefer to 
get their information visually, so you should look for alternatives to bullets. If you can replace words with a picture, 
graph, or flowchart - DO IT! And, when you do select your images, make sure they are high quality.  

When you are designing the look of your slides, add the consistent themes to the PowerPoint Slide Master so you 
can apply it to all of your slides, and then save the design as a template so you can easily use it the next time. When 
you are deciding on a text size you will use, make sure it is easily viewable in the 720x540 myBrainshark TV size. And 
no matter what template you use, you should adjust the size of the PowerPoint slides to be 20 x 15 in Page Setup for 
the best display in myBrainshark. 

When you upload your presentation to myBrainshark, your slide titles will be listed in “Contents”. If you want 
certain slides not to have visible titles, add them in PowerPoint and hide them either by moving them to the back of 
an overlying image or changing the text color to match the background color. If it is not possible to do this, you can 
easily change them in Brainshark, but just be aware that anytime you change the slide and re-upload it, you will 
need to go back and change the slide title in myBrainshark again. 
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Animations 

After you have built the content for your slides, add animations to help focus the viewer’s attention on what you are 
speaking about, and keep the slides moving. Think of presentations you have viewed in the past. Nothing is more 
boring than staring at the same screen while someone drones on in the background. Keep the interest of your 
viewers by keeping them on their toes! 

 

Ready, Set, myBrainshark! 

Once you have the main part of your presentation ready, it is time to get it into myBrainshark. 
 

1. Click Upload Content. 

2. Log into myBrainshark with your username and password. 

3. Choose the appropriate tab for the type of content you would like to upload. Content may be in the form of 
PowerPoint Presentations, videos, photos, images, documents, spreadsheets and more, but must be under 
200 MB. Supported file types are listed in the Helpful Hints section on each tab.  

4. Click the green Upload… or Record… button. 

5. Locate the file on your computer that you would like to upload and click Open. 

6. myBrainshark will upload and convert your content to a myBrainshark presentation. Upload and conversion 
time will vary based on the speed of your internet connection and the size of the file you are uploading.  

7. Enter a Presentation title or have Brainshark use the file name as the title of the presentation. 

8. Enter a short description of the presentation in the Description field. This description can be read and 
searched by myBrainshark users if the presentation is public, or by you if the presentation is private.  

9. Add Tags, which are searchable keywords or terms, to help you or your viewers find your presentation. 

10. Click Next when you are finished, and the upload and conversion process is complete. 

11. Once the file has converted, you will be prompted to add audio (unless it was previously embedding in your 
uploaded content), which is covered in the next section of this document. You can: 

a. Add audio right away using your computer microphone or telephone. 

b. Skip audio generation and add your audio later.   

12. Regardless of whether you add audio or skip audio generation, your Brainshark presentation can now be 
edited, made active, and shared. 
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How to Add and Manage Audio 

Add Audio using your Telephone 

The opportunity to add audio is presented automatically when you create a new presentation, and you can add or 

edit the audio on a presentation at any time. Using the telephone is a quick and easy way to record audio. Even 

though myBrainshark will record audio from any type of telephone, you will get the best quality audio if you use a 

corded, landline telephone, with the handset to your ear. To ensure higher quality, the use of headsets and 

speakerphones is not recommended. Additionally, you should plan to record in a quiet room to reduce background 

noise. 

1. Upload your presentation, or select your presentation 

from the library and navigate to Edit Presentation > 

Manage Audio > Record Audio. 

2. Use your telephone to dial the telephone number 

displayed in your browser window.  

3. When prompted, use your telephone keypad to enter 

the Presentation Access Code presented to you. 

NOTE: This code will change each time you select 

Record Audio. 

4. While you record, the menu of Telephone Keypad Commands (image at right) will display onscreen as a 

visual indicator of the options available during recording. 

5. The system always starts you on slide one of your content.  

6. Press [1]. Begin speaking at the tone; myBrainshark will record your audio. 

7. If your presentation has on-click animations, launch them while recording by clicking Next On-Click 

Animation to trigger each animation. myBrainshark will display the total number of animations on the slide, 

as well as the number of animations already timed.  

NOTE: You do not have to launch animations as you record. You can focus on delivering a quality recording 

and time your animations at a later time. When you are ready to time animations, view the presentation. 

Watch the audio counter and note the time that each animation should commence. Enter those timings in 

Edit Presentation > Manage Slides > Edit for each slide that has animations. 

8. Press [#] to stop and save the recording on the current slide. You will automatically be brought to the next 

slide.  
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9. To move to a specific slide while recording: 

a. Press [5], enter the desired slide number, and press [#].  

b. Or, press [4] to move backwards and [6] to advance through the slides one by one. 

10. To play the audio for any slide while recording: 

a. Move to the desired slide by pressing [5], enter the desired slide number, and press [#] 

b. Press [3] to play. 

11. When your recording is complete, hang up the phone to save your audio. You will be brought to Manage 

Properties where you can edit your presentation.  

 

Add Audio using a Microphone  

The opportunity to add audio is presented automatically when you create a new presentation, and you can add or 

edit the audio on a presentation at any time. Using a USB 

microphone to record is an easy way to record higher quality audio 

than you would get with a telephone recording; plan to record in a 

quiet room to reduce background noise. 

1. Upload your presentation, or select your presentation 

from the library and navigate to Edit Presentation > 

Manage Audio > Record Audio. 

2. Select Click here to record using your microphone.  

3. The system always starts you on slide one of your content.  

4. To record audio for a specific slide, select the desired slide 

in the Table of Contents.  

5. Click Record. After a 3-second onscreen countdown, 

recording will begin.  

6. During recording, the Recording Controls (image above) will display onscreen. Use the hyperlinked Table of 

Contents and the Record and Stop buttons to control the recording. 
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7. If your presentation has on-click animations, launch them while recording by clicking Next On-Click 

Animation to trigger each animation. myBrainshark will display the total number of animations on the slide, 

as well as the number of animations already timed.  

NOTE: You do not have to launch animations as you record. You can focus on delivering a quality recording 

and time your animations at a later time. When you are ready to time animations, view the presentation. 

Watch the audio counter and note the time that each animation should commence. Enter those timings in 

Edit Presentation > Manage Slides > Edit for each slide that has animations. 

8. Click Stop to end the recording.  

9. You will have the option to Preview, Save, Retry, or Discard; make your selection for this audio file.  

10. When you Save the audio, you will automatically be brought to the next slide.  

11. You can select a recorded slide and play the audio recorded for that slide by clicking Play. 

12. Click End Recording Session at the top right when the recording is complete; you will be brought to Manage 

Properties where you can edit your presentation.  

 

Upload Audio 

You might have access to a studio to record audio, or an audio recording program on your computer. Maybe you 

have recorded audio at an event and you want to attach that audio to your presentation. However you came by 

them, existing audio files are easy to repurpose in myBrainshark. When you have an .mp3 audio file for each slide in 

your presentation, follow this process:  

1. Select your presentation from your library then navigate to Edit Presentation > Manage slides. 

2. Navigate to the slide where you want to add the audio file; select Audio. 

3. If there is no audio on the slide, select Browse; if you want to change the audio currently on the slide, select 

Replace. 

4. Locate and select the .mp3 audio file for the chosen slide. NOTE: The upload limit of an individual audio file 

is 200MB. 

5. You can designate multiple audio files before you select Apply to preserve your changes and remain on the 

Manage Slides page, or Save your changes and return to the Presentation Properties tab. 
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Embed Audio  

If you have .wav audio files and are unable to convert them to .mp3 audio files, you can embed them slide-by-slide 
into PowerPoint and then upload the file to myBrainshark. Once your audio is in myBrainshark, it is converted to 
.mp3 format, and is available for download.  

NOTE: Once you embed audio to PowerPoint, the file size will increase. To see the size of your file, right-click the file 
icon and select Properties; the Size field will display the total file size. The maximum upload limit to Brainshark is 
200 MB. If your file size exceeds 200 MB, you can separate the PowerPoint file into multiple files of less than 200 MB 
each, and upload each file individually to Brainshark appending those slides to the existing slides in the presentation. 
Please refer to the Editing a myBrainshark Presentation  process document for further instructions.    

Embed Existing .wav Audio Files to PowerPoint 2003 

1. Open the PowerPoint presentation 

2. Select Tools > Options 

3. Select the General tab 

4. Modify the setting Link sounds with file size greater than…Kb to be 50000 (which is the maximum allowable 

file size in PowerPoint 2003) 

5. Click OK 

6. Select Insert | Movies and Sounds | Sound from File 

7. Navigate to the audio file and click OK 

8. You will be asked if you want to have the sound file played automatically in the slide show.  The audio file 

will start automatically when the slide begins playing in Brainshark regardless of whether you select Yes or 

No. 

9. Repeat for each slide where you want to insert an audio file. 

Confirm the files are Embedded 

1. Right click the sound icon on each slide where you inserted audio 

2. Select Edit Sound Object. Next to File, you should see [Contained in Presentation] 

3. If not, it is possible that your sound file is larger than 50MB which is the largest embeddable file size in 

PowerPoint 2003.   

 
For additional assistance, please contact Brainshark Support. 
 
  

http://www.brainshark.com/~/media/Files/Help-and-Training/Documents/Edit_myBrainshark.ashx
mailto:support@brainshark.com?subject=Help%20with%20existing%20audio%20files
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Embed Existing .wav Audio Files to PowerPoint 2007 or 2010 

1. Open the PowerPoint presentation 

2. Go to the slide where you want to insert audio 

3. Select Insert 

4. Select Audio from the Media group 

5. Select Audio from File 

6. Navigate to the audio file and click Insert 

7. Repeat steps to embed audio on additional slide(s) 

8. Once all embedding is complete, select File > Save As  

9. Change the Save as Type drop down to PowerPoint 97-2003 Presentation to ensure the file will play when 

uploaded to Brainshark. 

 
NOTE: PowerPoint 2010 will allow you to compress audio and media by going to File > Info > Media Size and 
Performance; this may help you reduce the file size enough that you may not have to split up the presentation slides 
before uploading to Brainshark. If your file size exceeds 200 MB, you can separate the PowerPoint file into multiple 
files of less than 200 MB each, and upload each file individually to Brainshark appending those slides to the existing 
slides in the presentation. Please refer to the Editing a myBrainshark Presentation  process document for further 
instructions.    
 

Background Audio 

myBrainshark allows you to apply background audio to your presentation. myBrainshark provides a library of audio 

files, but you can also upload or purchase your own. 

NOTE: Copyright laws apply to any audio or music files uploaded to myBrainshark and are the responsibility of the 

myBrainshark User. 

  

http://www.brainshark.com/~/media/Files/Help-and-Training/Documents/Edit_myBrainshark.ashx
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Add Background Audio to your presentation 

1. Select your presentation from your library then navigate to Edit Presentation > Manage audio > 

Background audio. 

2. Select Add Background Audio. 

3. Check the box next to the background audio file you wish to apply to your presentation. You may select 

more than one background audio file.  

4. Click Add Selected. In the next step, you will indicate the settings for each background audio file. 

5. Configure the Playback Settings. Once you have added the background audio file to your presentation you 

need to configure how the audio will play and for which slide(s) it will play. 

a. Playback Mode: there are two playback options for your audio files:   

i. Continuous will play the audio file continuously on the designated slides. 

ii. Play once will play the audio file through one time and then stop. 

b. Start Slide: select the slide where you want the audio file to begin playing. 

c. End Slide: select the slide where you want the audio file to stop playing. 

d. Volume %: select the volume at which the audio file will play. The default is 40% of 

your speaking volume. Adjust the volume by clicking the drop-down arrow. 

6. Click Save to save your settings and return to the Edit Presentation screen. 

 

Deleting a Background Audio Track from Your Presentation 

1. Select Manage Audio from the Things you can do menu. 

2. Select Background Audio. 

3. Select Delete located to the right of the audio track. 
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